
学习 目标

  •
 

理解虚拟漫游的概念。

•
 

了解虚拟漫游制作流程。

•
 

掌握虚拟场景的创建和漫游。

•
 

掌握虚拟场景跳转漫游与生成发布。

5.1 虚拟漫游概述

5.1.1 虚拟漫游简介

  虚拟漫游,是虚拟现实技术的重要分支,在建筑、旅游、游戏、航空航天、医学等多个行业

发展迅速,目前主要用于校园漫游、旅游教学、古迹复原、旅游模拟、城市规划等。由于具备

可贵的“3I”特性———沉浸感、交互性和构想性,使得沿用固定漫游路径等手段的其他漫游技

术和系统无法与之相比。
虚拟场景漫游是虚拟场景建立技术和虚拟漫游技术的结合。前者是基础,后者是系统

运行方法。其设计与实现方法可归纳为三种:
 

基于多边形的直接绘制法(简称直接建模

法)、场景模型导入法和基于图像的绘制方法。
(1)

 

基于多边形绘制的漫游系统。这种方法适合于场景组织不复杂、多边形数目比较

少的较规范、较简单或简化的场景绘制。例如,建筑物远观或大场景的建筑点缀等。
(2)

 

基于模型导入的漫游系统。这种方法通常利用造型软件(如3ds
 

Max、Maya等)手
工搭建三维模型,建立场景,因而需要耗费大量的时间,工作量很大,一般涉及测量现场、定
位和数字化结构平面或者转换现存CAD数据;

 

其次很难校验其结果是否精确。其漫游场

景是由计算机根据一定的光照模型绘制,色彩层次没有自然景观丰富,带有明显的人工痕

迹,即使采用贴图渲染也不能逼真地再现现实世界。随着建模软件的功能日益强大,设计中

人们的分工日益明确,人们可以利用日益精细的建筑模型和丰富的模型库资源来加快设计,
这一基于几何建模的模型导入技术已成为当今游戏设计等领域的主流技术。
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(3)
 

基于图像的虚拟场景漫游。基于图像的虚拟场景漫游,是利用在某一固定位置所

抓取的一个环境的360°全景图像,通过展现全景图像的相应部分来实现相互的调整。人们

所熟悉的全景图像技术就是利用系列局部图像拼接起来的,能够进行全视野、360°全方位环

视漫游的图像环境。这种技术可以避免复杂的三维建模工作,所以更适合复杂的自然风光、
地景的漫游。

虚拟场景漫游的最大特点是硬件要求低、图形处理速度快、高效的网络分布式计算。在

大规模场景仿真方面,它通过地块的动态调度、物体细节等级的智能变化、快速消隐等算法使

任意规模的场景都可以在普通计算机平台上实时仿真。在数据管理方面,它能够与现有数据

库进行有效对接,达到可视化对象和后台数据信息的有效关联,从而实现数据管理和查询。
虚拟场景漫游方案具有以下特色。
(1)

 

模拟场景的实时漫游。支持鸟瞰、步行、飞行等多角度对整个景区进行全方位的观

赏。三维场景具有固定线路和自主漫游功能。通过键盘的简单结合或触摸屏可以方便灵活

地实现漫游:
 

前进、后退、左转、右转、左平移、右平移、上升、下降、仰视、俯视等一系列漫游

操作。通过键盘上设定的按键就可以对漫游速度进行自由控制。
(2)

 

身临其境的感受。虚拟现实漫游系统所创造的平台,通过3D建模根据实际场景进

行等比例的建模,然后通过高级材质球,打造逼真的场景还原。最后通过渲染引擎,在漫游的

同时,实时渲染场景。例如,太阳光和阴影的实时更新、24h天气效果模拟、春夏秋冬效果等。
(3)

 

支持快捷聚焦功能。可以在固定路线和自由漫游中实时切换相机焦距,并具备焦

距切换快捷键。在固定路线的游览教学中,可对游览路线进行暂停、播放和停止的操作,暂
停后可以360°环视场景,并能对漫游速度进行方便调节;

 

利用鼠标、键盘、操纵杆等通用交

互设备,操作者可以在虚拟场景内若干条特定路线设定导航路径,操作简单直观,初学者即

可很方便地控制速度、方向、观测角度、高度等漫游模式。也可对特定景物进行细节聚焦、

360°展看,并且可对游览路线进行暂停、播放和停止的操作。
虚拟场景漫游的制作技术主要包括虚拟场景制作技术和场景交互技术。
虚拟场景制作通常包括两种方法:

 

一种方法是利用三维建模软件(通常是3ds
 

Max、

Maya等),根据真实场景的客观数据制作三维模型,然后将多个三维模型搭建成虚拟场景;
 

另一种方法是利用摄像设备扫描周围空间的真实图像,再将图像拼接成全景图实现场景的

虚拟再现,此技术即是全景图技术。而场景交互技术是通过引擎软件(通常是 Unity或

Unreal)设计场景的交互操作,例如,自主漫游、自动漫游和鼠标交互、人机交互等。本章重

点介绍三维模型搭建场景的虚拟漫游的制作步骤。

5.1.2 虚拟漫游制作流程

虚拟场景漫游的制作流程通常分为4个步骤:
 

场景设计、三维建模、场景搭建和人机交

互,如图5.1所示。

图5.1 虚拟场景漫游制作流程

场景设计是对场景的布局,设计场景中物体的大小、形状和位置等信息。
三维建模是利用3D建模软件(3ds

 

Max、Maya等)创建场景中物体的三维模型。
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场景搭建是根据场景的设计方案,利用引擎软件(Unity或 Unreal)将三维模型拼接起

来,形成相对完整的场景,并添加物理碰撞系统,模拟真实的碰撞效果。
人机交互是利用脚本控制语句(C#、C++等),实现自由漫游、自主漫游、鼠标交互操作

甚至沉浸式交互漫游等。
本章案例以3ds

 

Max创建的虚拟场景为基础,讲授Unity
 

3D虚拟漫游的制作,重点讲

解通过导入三维模型进行场景的搭建和人机交互的初步实现。

5.2 虚拟漫游与交互设计

打开Unity软件,新建3D工程文件,设置保存工程文件的路径,单击“创建”按钮。注

意项目名称和工程文件保存路径不要使用中文,推荐使用Unity
 

Hub新建项目。

5.2.1 虚拟场景的创建

1.
 

导入标准资源包

  打开新建工程,在Project窗口中右击,选择Import
 

Package命令,选择 Unity标准资

源包Standard
 

Assets,单击Import按钮,导入Environment模型、Characters模型和贴图素

材包等资源,如图5.2所示。本节使用标准资源包创建一个简单地形效果,读者也可以搜索

相关三维地形生成软件,如 World
 

Creator、QuadSpinner
 

Gaea等,可以根据个人需求,快速

模拟各种自然地形效果。

图5.2 标准资源包
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2.
 

绘制地形

在Hierarchy窗口空白处右击,选择3D
 

Object→Terrain命令创建一个基本地形。选

择Terrain,可以在Inspector视图的 Terrain组件中找到 Mesh
 

Resolution属性,设置

Terrain选项,如图5.3所示。这里设置Terrain
 

Width和Terrain
 

Length均为100。

图5.3 设置地形参数

选择Terrain,在Hierarchy视图中选择主摄像机,可以在Scene视图中观察到地形,将
其移到主摄像机适当的位置。在右边Inspector视图的Terrain组件中选择Rains/Lower

 

Terrain工具,选择笔刷样式,然后在地形上刷就可以刷出突出山形,按住Shift键单击可以

让山形重新凹平下去。
选择Smooth

 

Height工具,可以平滑山形,使得地形过渡自然,不那么陡峭。可以先用

大笔刷刷出大概,再用小笔刷刷细节,最后用笔刷平滑。选择不同的笔刷与贴图以及下面对

笔刷大小等设置就可以刷出更复杂的地形来。选择Paint
 

Height工具,然后选择“笔刷”可
以输出平顶的山形,绘制地形效果如图5.4所示。

图5.4 绘制地形效果
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3.
 

绘制纹理

选择Paint
 

Texture绘制纹理,然后选择Edit
 

Terrain
 

Layers→Create
 

Layer命令添加

图5.5 添加纹理图层

地形图层,如图5.5所示,这个操作可以反

复执行多次添加多个地形图层,最后在图层

中选择需要的贴图,将贴图画在Terrain上

面。注意在Tiling
 

Setting中设置贴图的尺

寸,并选择笔刷(Brushes)的大小、类型。

4.
 

绘制树木

选择Terrain组件中的Paint
 

Trees(绘
制树木)工具,选择Edit

 

Trees→Add
 

Tree
命令弹出对话框,选择 Tree

 

Prafab模型,这样操作也可以执行多次加入多个模型。在

Trees中选择需要的模型,设置好绘制树木笔刷的大小、树的密度、高度和其他参数,然后在

地形上单击鼠标即可将树木绘制到Terrain上面,绘制树木效果如图5.6所示。

图5.6 绘制树木效果

树木是固定的、从地形表面生长出的三维对象。当一棵树被选中时,可以在地表上用绘

制纹理或高度图的方式来绘制树木,为保证好的渲染效果,Unity
 

3D对远距离树木进行了

优化,以保持可以接受的帧率。按住Shift键并单击可从区域中移除树木,按住Ctrl键并单

击则只绘制或移除当前选中的树木。

5.
 

绘制细节

选择Terrain组件中的Paint
 

Details(绘制细节)工具,选择Edit
 

Details→Add
 

Grass
 

Texture命令弹出对话框,选择Detail
 

Texture模型设置草地细节,如图5.7所示。这样操

作也可以执行多次加入多个模型。草地使用二维图像进行渲染来表现草丛,而其他细节从

标准网格中生成,绘制草地贴图效果如图5.8所示。注意,该效果在远视角中不可见。

6.
 

添加水特效

找到 Water文件夹下的Prefab文件夹,其中包含两种水特效的预制件,可将其直接拖
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图5.7 设置草地细节

图5.8 绘制草地贴图效果

曳到场景中,这两种水特效功能较为丰富,能够实现反射和折射效果,并且可以对其波浪大

小、反射扭曲等参数进行修改。
单击Unity

 

3D编辑器上的“运行”按钮,如图5.9所示,可以观察水效果。水波荡漾,效
果比较符合现实。

7.
 

加入天空盒

完整的漫游场景还需要使用Skybox(天空盒)技术来实现天空的效果,Skybox资源并

不包含在标准资源包中,需要用户通过外部导入。导入的天空盒资源包可以来自第三方建

模软件开发的资源,也可以是在Unity
 

3D资源商店中共享的资源。在Project窗口中右击,
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图5.9 添加水特效

选择Import
 

Package→Custom
 

Package命令,选择要导入的SkyBox.unitypackage资源包。
读者可以将Project中SkyBox文件夹中的天空盒直接拖曳到Scene中,也可以通过菜单添

加。在场景中选择 Main
 

Camera摄像机,在菜单栏中选择 Component→Rendering→
Skybox命令为其添加Skybox组件,将Clear

 

Flags设置为Skybox,在Custom
 

Skybox中选

择Skybox24天空模型,如图5.10所示。

图5.10 创建Skybox材质
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在菜 单 栏 中 选 择 Window→Lighting命 令,为 场 景 添 加 Skybox组 件,在 Skybox
 

Material中选择Skybox24天空模型,如图5.11所示。

图5.11 设置Lighting窗口

单击Unity
 

3D编辑器上的“运行”按钮,如图5.12所示,可以看到天空效果。

图5.12 加入天空效果

8.
 

导入三维模型

在Project窗口中,右击,在弹出菜单中选择Import
 

Package命令,分别导入利用三维

建模软件创建的资源包 House、Boat和Simple
 

Wood
 

Bridge。在打开的对话框中,单击

Import按钮,将资源导入到工程窗口中。然后,选择导入的资源的预制体Prefab,按照场景
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要求拖入Scene场景中,并通过位移、缩放、旋转等操作,对场景内的资源进行布局。最终场

景效果如图5.13所示。

图5.13 最终场景效果

9.
 

添加物理碰撞

碰撞系统是模拟物体遇到障碍物时的物理响应。众所周知,物体在没有添加碰撞时,在
场景中漫游会无视所有的物体,直穿而过。例如,场景中的建筑物会发生穿过墙体的现象,
不符合实际情况。所以,为了逼真地模拟现实,需要对场景中的物体添加碰撞,它是漫游系

统真实性实现的方式之一。
由于地面是由自带碰撞系统的Terrain地形制作而成,所以不需要添加碰撞系统。而

对于其他的,尤其是资源包中导入的模型,则需要添加碰撞。
选中场景中的小房子,在Inspector窗口中,单击Add

 

Component按钮添加Box
 

Collider组

件,然后单击所选物体的Inspector中Box
 

Collider组件中的Edit
 

Collider按钮,如图5.14
所示,此时包围物体的碰撞体为可编辑状态,每个碰撞面的中心都有一个可编辑点,通过拖

曳可编辑点实现对碰撞范围的编辑,最终使得碰撞体紧密包围建筑物即可。

图5.14 添加碰撞体
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5.2.2 虚拟漫游的实现

虚拟场景中的自主漫游,比较简单且常用的方式是用Unity
 

Standard
 

Assets中导入的

Characters包,如图5.15所示,里面包含第一人称控制器FPSController,将第一人称控制

器的FPSController.prefab预制体拖入场景中就可以用 W、S、A、D按键实现前、后、左、右
移动,控制器自带脚步音效,如图5.16所示,在第一视角的虚拟场景漫游中经常使用。需要注

意的是,当把第一人称控制器的预制体拖入场景后,因其绑定有Camera组件,需要关闭或删除

Hierarchy窗口中系统自带的Main
 

Camera(主摄像头)才可以避免冲突,实现自主漫游。为了

便于操作,在测试运行阶段也可以将鼠标在屏幕上显示出来,通过设置FPSController的

Inspector窗口中First
 

Person
 

Controller(Script)组件中的 Mouse
 

Look属性,取消Lock
 

Cursor参数即可。

图5.15 第一人称控制器

图5.16 添加第一人称预制体

需要提醒的是,在加入角色控制器后,运行有时会出现视线一直在往下掉的情况,用户

会看到 前 面 加 入 的 树 和 地 面 在 往 上 升,这 是 因 为 重 力 的 作 用,必 须 将 First
 

Person
 

Controller的Gravity
 

Multiplier选项设置为0,默认是2,这样就不会发生往下掉的情况了。
如图5.17所示为第一视角自主漫游效果。
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图5.17 第一视角自主漫游效果

5.2.3 虚拟场景中的交互

完成虚拟场景第一视角自主漫游的功能后,接下来将通过为用户制定多种漫游方式(自
动漫游、自主漫游),并通过按钮调用,来实现可视化集成虚拟场景漫游系统的所有功能。

1.
 

添加跳转按钮

(1)
 

打开场景 Wandering,在Hierarchy窗口中右击,选择UI→Button命令新建一个按

钮。选中Button,在Inspector窗口中,将其名字修改为Automatic,如图5.18所示。

图5.18 修改Button名字

(2)
 

选中Automatic按钮,在Inspector中,通过Rect
 

Transform调整其在屏幕中的位

置。选择九宫格图标,按住Shift键和鼠标左键,设置锚点在屏幕的正中间。按住Alt键和

鼠标左键,设置Automatic按钮控件在屏幕的左下方。相关操作如图5.19所示。
(3)

 

利用Photoshop软件创建透明背景的“自动漫游”按钮图标,将按钮导入Project窗

口中,在图标的Inspector中,修改 Texture
 

Type类型为Sprite(2D
 

and
 

UI),如图5.20
所示。
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图5.19 设置按钮控件位置 图5.20 设置图标Texture
 

Type

(4)
 

在Project窗口中,选择Automatic,删除下属子控件Text,调整Inspector中Width
和Height的值到合适大小,并修改Image组件的Source

 

Image值,选择“自动漫游”图标。
调整后按钮组件如图5.21所示。

图5.21 调整后按钮组件

(5)
 

以同样的方式,添加“退出”按钮,效果如图5.22所示。

图5.22 按钮效果

2.
 

自动漫游的实现

虚拟场景中的自主漫游,是以第一人称的角色视角浏览场景,通过 W、A、S、D键或上、
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下、左、右方向按键控制角色的位置,拖曳鼠标进行视角的旋转,空格键完成跳跃。自动漫游

与自主漫游不同,是通过特定触发条件,允许角色沿着既定路线进行漫游,可以通过

Animator控制摄像机运动来实现。接下来我们通过关键点和漫游动画的制作,分别实现基

于按钮的自动漫游和基于导航组件的自动漫游。

1)
 

关键点的制作

(1)
 

执 行 File菜 单 下 的 Save
 

as命 令,将 场 景 另 存 为 AutoWandering,然 后 删 除

AutoWandering场景的 Hierarchy窗口中非场景模型和灯光的其他物体,包括FPSController、

Canvas等,仅保留场景模型和灯光。
(2)

 

在AutoWandering场景的 Hierarchy窗口中,右击选择新建Camera摄像机并选

中,然后选择菜单 Window→Animation→Animation命令,弹出 Animation动画窗口,如
图5.23所示,单击Create按钮,新建动画AAutoMaticAni.anim。

图5.23 Animation动画窗口

(3)
 

单击Add
 

Property按钮,选择Camera的Transform属性,为摄像机的Position和

Rotation设置属性值。属性设置如图5.24所示,其中,方框内的数据为当前相机的位置和

角度的数值。

图5.24 属性设置
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(4)
 

在Scene场景中,按漫游设定的路线移动摄像机Camera,确定下一个Camera位

置,调 整 视 角,按 Shift+Ctrl+F 组 合 键 将 摄 像 机 视 角 与 Scene视 角 同 步。然 后 在

Animation窗口中选择时间点,单击Add
 

keyframe按钮添加关键帧。如图5.25所示,重复

此过程,直到漫游路线的最后一个位置,即可获得摄像机的运动路径。为方便时间点选择,
在Animation窗口中滚动鼠标滚轴可以缩放时间轴视图。

图5.25 摄像机的运动路径

(5)
 

单击Animation对话框中的“录制”按钮,完成动画的录制。
(6)

 

关闭Animation对话框后,在Project中选择 AutoMaticAni动画,在其Inspector
窗口中,取消勾选Loop

 

Time选项,取消后Inspector窗口如图5.26所示。

图5.26 取消勾选Loop
 

Time

2)
 

漫游动画的制作

(1)
 

选择菜单栏 Window→Animation→Animator命令,打开Camera的Animator窗

口,右击选择Create
 

State→Empty命令,新建一个空的状态New
 

State,新建过程如图5.27
所示。

(2)
 

选择New
 

State,右击选择Set
 

as
 

Layer
 

Default
 

State将其设置为默认的初始状态,
设置过程如图5.28所示。
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图5.27 新建空的状态

图5.28 默认初始的状态

(3)
 

选择New
 

State,右击选择Make
 

Transition命令,创建New
 

State与AutoMaticAni之

间的链接。同样,选择AutoMaticAni,右击选择 Make
 

Transition命令,创建AutoMaticAni与

New
 

State之间的链接,如图5.29所示。
(4)

 

设置状态转换的条件。选择Animator窗口左侧的Parameters,单击“+”(添加)按
钮,在弹出的下拉菜单中选择Bool,创建布尔类型的变量,如图5.30所示。在新建的框体
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图5.29 创建状态之间的链接

中输入变量的名字“IsRun”,名字后面的复选框,如果处于选中状态,表示变量的初始值为

True;
 

如果处于未选中状态,表示变量的初始值为False。本案例中IsRun的初始值为

Flase,即不勾选复选框。
(5)

 

使用变量IsRun对Animator中的连线设置条件。通过鼠标单击选择New
 

State
到AutoMaticAni的连线,在Inspector窗口中,取消 Has

 

Exit
 

Time的选择,单击“+”按钮

添加变量IsRun,设置值为True,如图5.31所示。

图5.30 创建布尔类型的变量 图5.31 设置New
 

State到AutoMaticAni的条件

(6)
 

同样的方法,在 Animator窗口中选择 AutoMaticAni到 New
 

State的连线,单击

“+”按钮添加变量IsRun,设置值为False,如图5.32所示。
(7)

 

在AutoWandering场景中添加“返回”按钮,作为中断自动漫游返回主页面的快捷

方式,效果如图5.33所示。创建的添加和定位方法类似“自动漫游”按钮,这里就不再赘述。
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图5.32 设置AutoMaticAni到New
 

State的条件

图5.33 “返回”按钮

3)
 

漫游动画的控制

(1)
 

打开 Wandering场景,为了实现单击“自动漫游”按钮进行场景跳转的功能,需要为

“自动漫游”按钮添加场景跳转控制代码。
(2)

 

在Project窗口中,右击新建C#
 

Script,重命名为AutoWanderingScript.cs。然后双击

打开,在程序编辑器中输入以下代码。这里需要注意的是,因为要操作按钮进行场景跳转,所
以需要引入类UnityEngine.UI和SceneManagement。最后,将AutoWanderingScript脚本文件

拖曳到Hierarchy窗口中的Automatic“自动漫游”按钮上。AutoWanderingScript.cs代码如下。

  using
 

System Collections 
using

 

System Collections Generic 
using

 

UnityEngine 
using

 

UnityEngine UI 
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using
 

UnityEngine SceneManagement 
public

 

class
 

AutoWanderingScript
 

 
 

MonoBehaviour
 
    

 

Start
 

is
 

called
 

before
 

the
 

first
 

frame
 

update
  void

 

Start  
   
    GetComponent Button   onClick AddListener OnClick  

   

   监听按钮

   
  void

 

OnClick  
   
    SceneManager LoadScene "AutoWandering"  

   

  场景跳转

   
 

(3)
 

为了使自动漫游能够自动运行,还需要用代码控制 AutoWandering场景中的

Camera的动画控制器AutoMaticAni。新建C#
 

Script,重命名为RunScript.cs,将其挂载

到Camera摄像机上。RunScript.cs代码如下。

  using
 

System Collections 
using

 

System Collections Generic 
using

 

UnityEngine 
public

 

class
 

RunScript
 

 
 

MonoBehaviour
 
  private

 

Animator
 

ani 
    

 

Start
 

is
 

called
 

before
 

the
 

first
 

frame
 

update
  void

 

Start  
   
    ani

 

=
 

GetComponent Animator   
   

   找到动画控制器

    ani SetBool "IsRun" true  
   

  设置动画控制器变量的值

   
    

 

Update
 

is
 

called
 

once
 

per
 

frame
  void

 

Update  
   

   

   
 

4)
 

基于导航组件实现自动漫游

“自动漫游”可以理解为通过构造一系列关键点组成的行走路线,程序控制按照规定好

的路线来漫游场景。Unity中自带的导航系统(Navigation)是实现动态物体自动寻路的一

种技术,根据开发者所编辑的场景内容,自动地生成用于导航的网格。实际导航时,只需要

给导航物体挂载导航组件,导航物体便会自行根据目标点来寻找符合条件的路线,并沿着路

线行进到目的地。因此,自动漫游也可以借助Navigation系统来实现。具体过程如下。
(1)

 

前期静态导航设置。将 AutoWandering场景中的所有几何对象选中,然后在

Inspector视图中,在Static下拉列表中勾选Navigation
 

Static,将所有对象标记为Navigation
 

Static(静态导航)。
(2)

 

烘焙导航网格。选择菜单栏中的 Window→AI→Navigation命令,如图5.34所示,
在弹出的Navigation窗口中,单击Bake标签,设置Bake选项卡中的各项参数,例如,Agent

 

Radius设置为0.3,Agent
 

Height设置为1,Step
 

Height设置为0.5等。然后单击右下角
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的Bake按钮,烘焙生成导航网格效果如图5.35所示。

图5.34 Navigation窗口

图5.35 烘焙生成导航网格

(3)
 

创建导航代理。新建一个Capsule对象并命名为Player,设置其Scale为(0.5.1.0.5),
然后选择菜单栏中的Component→Navigation→NavMesh

 

Agent命令,为Player对象添加导航

代理组件。
(4)

 

设置漫游路径的关键点。添加一个空物体,命名为Nav_Patrolling。然后,创建多

个空物体作为Nav_Patrolling的子物体,放置在场景的关键位置,分别以漫游的顺序序号命

名,代表着漫游路径中的关键点,关键点名称如图5.36所示。
(5)

 

代码控制实现自动漫游。在Project窗口中创建C#
 

Script代码,命名为 Nav_

Patrolling.cs,然后将代码绑定到移动对象Player中,并将Nav_Patrolling组件中的路径设

为代码中的漫游关键点patrolWayPoints。Nav_Patrolling.cs代码如下。
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图5.36 关键点

  using
 

System Collections 
using

 

System Collections Generic 
using

 

UnityEngine 
using

 

UnityEngine AI 
public

 

class
 

Nav_Patrolling
 

 
 

MonoBehaviour
 
  public

 

float
 

patrolSpeed
 

=
 

2f 
   

          漫游的速度
  public

 

float
 

patrolWaitTime
 

=
 

1f 
   

  每个关键点等待的时间为1s
  public

 

Transform
 

patrolWayPoints 
   

  漫游点
  private

 

NavMeshAgent
 

agent 
   

  智能体
  private

 

float
 

patrolTimer 
   

  每个关键点的停留时间
  private

 

int
 

wayPointIndex 
   

  漫游关键点的编号
    

 

Start
 

is
 

called
 

before
 

the
 

first
 

frame
 

update
  void

 

Start  
   
    agent

 

=
 

GetComponent NavMeshAgent   
   

  找到漫游的智能体
   
    

 

Update
 

is
 

called
 

once
 

per
 

frame
  void

 

Update  
   
    Patrolling   
   
  void

 

Patrolling  
   
    agent speed

 

=
 

patrolSpeed 
    if

 

  agent pathPending
 

&&
 

agent remainingDistance
 

=
 

agent stoppingDistance   剩余
  距离小于stoppingDistance则计算持续时间 否则持续时间为0
     
      patrolTimer

 

+=
 

Time deltaTime 
   

  持续时间
      if

 

 wayPointIndex
 

==
 

patrolWayPoints childCount
 

-
 

1   如果是最后一个结点 则
  编号为0 否则++ 持续时间改为0
       
        wayPointIndex

 

=
 

0 
       
      else
       
        wayPointIndex++ 
       
      patrolTimer

 

=
 

0 
     
   else 
   patrolTimer=0 
       
    agent destination

 

=
 

patrolWayPoints GetChild wayPointIndex  position 
   

  制定下一
  个目标点的位置
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设置关键点后,Nav_Patrolling组件如图5.37所示。

图5.37 Nav_Patrolling组件

(6)
 

相机跟随Player,提升沉浸体验效果。采用固定摄像机的方法,将摄像机放置在主

角头部上方靠后的位置,在主角移动的过程中,摄像机也随着移动。在Project窗口中创建

C#
 

Script代码,命名为CameraFollow.cs,代码挂载在Camera上,并将移动对象Player与

代码中的follow相连。CameraFollow.cs代码如下。

  using
 

System Collections 
using

 

System Collections Generic 
using

 

UnityEngine 
public

 

class
 

CameraFollow
 

 
 

MonoBehaviour
 
  public

 

float
 

disAway
 

=
 

1 7f 
  public

 

float
 

disUp
 

=
 

1 3f 
  public

 

float
 

smooth
 

=
 

2f 
  private

 

Vector3
 

m_TargetPosition 
  public

 

Transform
 

follow 
    

 

Start
 

is
 

called
 

before
 

the
 

first
 

frame
 

update
  void

 

Start  
   
   
      

 

Update
 

is
 

called
 

once
 

per
 

frame
  void

 

Update  
   
    m_TargetPosition

 

=
 

follow position
 

+
 

Vector3 up
 

*
 

disUp
 

-
 

follow forward
 

*
 

disAway 
    transform position

 

=
 

Vector3 Lerp transform position m_TargetPosition Time 
deltaTime*smooth  
    transform LookAt follow  
   
 

在运行的过程中,如果不想看到第三人称对象Player,则可以选择Player的Inspector
窗口下的 Mesh

 

Renderer,取消勾选即可。

3.
 

返回与退出

“返回”按钮的功能是从自动漫游的场景跳转到初始场景,“退出”按钮的功能是结束程

序,退出漫游场景。

1)
 

“返回”按钮的实现

从自动漫游的场景返回,首先需要将自动漫游场景中的自动漫游关闭,然后再跳转到初

始场景。“返回”按钮的代码为BackScript.cs,编辑完成后将BackScript.cs文件直接拖放

到AutoWandering场景的Hierarchy窗口中的Return按钮上。BackScript.cs代码如下。
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  using
 

System Collections 
using

 

System Collections Generic 
using

 

UnityEngine 
using

 

UnityEngine UI 
using

 

UnityEngine SceneManagement 

public
 

class
 

BackScript
 

 
 

MonoBehaviour
 
  private

 

Animator
 

ani 
    

 

Start
 

is
 

called
 

before
 

the
 

first
 

frame
 

update
  void

 

Start  
   
    GetComponent Button   onClick AddListener OnClick  
    ani

 

=
 

GameObject Find "Camera"  GetComponent Animator   
 

  void
 

OnClick  
   
    ani SetBool "IsRun" false  

   

  动画关闭 设置变量IsRun为False
    SceneManager LoadScene "Wandering"  
   
 

2)
 

“退出”按钮的实现

“退出”不是退出自动漫游状态,而是退出整个虚拟漫游系统,结束虚拟漫游程序,所以

通常出现在最顶层的界面或漫游窗口中。“退出”按钮的代码是ExitScript.cs,编辑完成后将

ExitScript.cs直接拖入 Wandering场景的Hierarchy窗口中的Exit按钮上。ExitScript.cs代码

如下。

  using
 

System Collections 
using

 

System Collections Generic 
using

 

UnityEngine 
using

 

UnityEngine UI 
using

 

UnityEngine SceneManagement 

public
 

class
 

ExitScript
 

 
 

MonoBehaviour
 
    

 

Start
 

is
 

called
 

before
 

the
 

first
 

frame
 

update
  void

 

Start  
   
    GetComponent Button   onClick AddListener OnClick  
   
    

 

Update
 

is
 

called
 

once
 

per
 

frame
  void

 

OnClick  
   
    Application Quit   
   
 

至此,自主漫游和自动漫游功能均已经实现,选择File→Build
 

Setting命令,在弹出的

对话框中,分别将 Wandering和AutoWandering场景添加到生成场景中,即可通过按钮实
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现两种不同漫游方式的切换。场景漫游最终效果如图5.38所示。

图5.38 自主漫游与自动漫游场景效果

5.3 虚拟场景的跳转

5.3.1 场景的创建与管理

  为丰富场景漫游的内容,可以利用外部资源导入的方式构建新的场景。在Project窗口

中右击,选择Import
 

package→Custom
 

package命令,在弹出的窗口中选择POLYGON
 

City
 

Pack.unitypackage。这是由Synty
 

Studios呈现的一个包含角色、建筑物、道具、车辆

和环境资产的低多边形资产包,用于创建基于城市的多边形风格游戏。
导入资源后,在Project中会出现POLYGON

 

city
 

pack文件夹,找到并双击打开scene
文件夹下的DemoScene.unity,可以看到如图5.39所示场景效果。

选择Standard
 

Assets→Characters→FirstPersonCharacter→Prefabs→FPSController.
prefab文件,将其拖曳到DemoScene场景中,调整到合适的位置,单击“运行”按钮,即可实

现第一人称视角的自主漫游。注意:
 

为了防止边缘跌落,建议创建一个Cube并调整合适宽

度和高度,摆放在碰撞无法通过的位置,取消勾选网格碰撞器 Mesh
 

Collider即可形成一堵

隐形的碰撞墙。

5.3.2 虚拟漫游的界面设计

虚拟漫游的界面设计通常采用 UI元素实现,本例通过三个按钮分别实现两个场景的
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图5.39 DemoScene场景效果

漫游进入和退出漫游系统功能,步骤如下。
(1)

 

添加新Scene,在 Hierarchy窗口中右击添加 UI→Image,并将Image修改为

background。选择background对象,单击Inspector窗口,按住键盘上的Alt键,同时单击

Inspector窗口中的stretch图标,此时可以将background对象铺满整个UI界面背景。
(2)

 

导入bg.jpg图片并选中,在Inspector中修改纹理类型为Sprite(2D和 UI),单击

右下角的Apply按钮,然后将其拖曳到background对象Image组件SourceImage中,也可

以直接拖曳到Hierarchy窗口的background上。
(3)

 

给background对象添加子元素Button,修改Button名称为 Nature,删除Button
子元素Text,通过精灵图片替换Inspector窗口中按钮的Source

 

Image,得到“漫游自然”按
钮。采用类似方法分别添加“漫游城市”和“退出”按钮,效果如图5.40所示。

图5.40 漫游系统界面
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(4)
 

保存场景名为Start.unity,并将其加入到Build
 

Setting窗口Scenes
 

In
 

Build选框

中,并确保Start场景编号为0。
截至 目 前,在 Project中 一 共 添 加 了 4 个 场 景,分 别 为 Start、AutoWandering、

Wandering和DemoScene,打开File菜单下的Build
 

Setting窗口,可以利用鼠标直接将其

他三个场景从Project窗口拖曳添加到Scenes
 

In
 

Build选框中,此时四个场景均有一个编

号。Build
 

Setting设置如图5.41所示。

图5.41 Build
 

Setting设置

5.3.3 场景跳转漫游

本节想实现的效果,是通过一个Start场景的UI界面上的按钮,分别触发前面完成的

Wandering和City两个场景的漫游。其中,Wandering除了可以自主漫游外,还保留“自动

漫游”按钮和返回功能,在 Wandering场景窗口中的“退出”按钮可以返回到Start起始场景

UI。不管是 Wandering和City任一场景的漫游过程中,只要按了Esc键即可终止漫游,返
回到Start起始场景UI,UI界面中的“退出”按钮可以终止漫游程序,退出虚拟场景。实现

过程主要从两个方面考虑,一是单击UI界面按钮的进入环节,二是漫游过程中的返回和退

出环节。

1.
 

UI界面按钮实现场景跳转

在Project窗口中右击,新建C#
 

Script,保存名称为Control.cs,代码如下。

  using
 

System Collections 
using

 

System Collections Generic 
using

 

UnityEngine 
using

 

UnityEngine SceneManagement 
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public
 

class
 

Control
 

 
 

MonoBehaviour
 
  public

 

GameObject
 

UIbg 

    
 

Start
 

is
 

called
 

before
 

the
 

first
 

frame
 

update
  void

 

Start  
   
    UIbg SetActive true  
   

  public
 

void
 

Return  
 

 
    SceneManager LoadScene 0  
    UIbg SetActive true  
   
  public

 

void
 

Quit  
 

 
    Application Quit   
   
  public

 

void
 

LoadScene1   
    SceneManager LoadScene 1  
   
  public

 

void
 

LoadScene3  
   
    SceneManager LoadScene 3  
   
 

将完成后的Control.cs代码挂载到Hierarchy窗口中的Canvas画布上,并通过鼠标拖

曳设置Control组件的UIbg为background,此时Control组件设置如图5.42所示。

图5.42 Control组件设置

单击Exit按钮,在Inspector窗口中设置Button组件的 OnClick()事件,添加Canvas
对象,并选择Control.Quit事件方法。此时OnClick()属性设置如图5.43所示。

图5.43 属性设置

同样方法,分别为Nature按钮设置Button中的OnClick()事件,添加Canvas对象并选

择Control.LoadScene1事件方法,为 City按钮设置 Button中的 OnClick()事件添加

Canvas对象并选择Control.LoadScene3事件方法,最后保存场景Start。

2.
 

漫游过程中按Esc键返回

在Project窗口中右击,新建C#
 

Script,保存名称为Getout.cs,代码如下。

  using
 

System Collections 
using

 

System Collections Generic 



216  

using
 

UnityEngine 
using

 

UnityEngine SceneManagement 

public
 

class
 

Getout
 

 
 

MonoBehaviour
 
    

 

Update
 

is
 

called
 

once
 

per
 

frame
  void

 

Update  
   
  if Input GetKeyDown KeyCode Escape →→Input GetKeyDown KeyCode Home  
     
      SceneManager LoadScene 0  
     
   
 

打开 Wandering场景,在 Hierarchy窗口中选中FPSControl对象,将代码Getout.cs挂

载到第一视角FPSControl对象身上。注意,如果弹出Cannot
 

restructure
 

Prefab
 

Instance警告

窗口,单击Open
 

Prefab按钮即可。
打开DemoScene场景,在Hierarchy窗口中选中FPSControl对象,同样方法确保将代

码Getout.cs挂载到第一视角FPSControl对象身上。这样就可以实现在漫游过程中,可以

随时通过按Esc键返回到Start场景UI界面。
注意:

 

测试运行的虚拟漫游很多功能无法呈现,尤其是按钮的触发效果,只有发布出来

才可以完整运行。同时,在跳转到其他场景漫游时,跳转后的场景会出现光照烘焙的问题,
缺乏光照效果。解决的办法是提前进行光照渲染。

要为多个场景同时烘焙光照贴图,只需要打开所有需要操作的场景,在 Window→
Rendering→Lighting窗口中关闭 Auto

 

Genarate选项,然后单击Genarate
 

Lighting按钮

即可。

5.4 虚拟漫游系统的设置与发布

选择File→Build
 

Setting命令,可以打开发布设置窗口,如图5.44所示,其中包含多个

发布选项。Unity开发的项目支持发布到多个平台,Web和PC版是免费发布的,其他平台

的发布则需要付费并安装相应的发布插件。发布出来的虚拟场景漫游系统在任何一台不联

网的对应类型PC上都可以运行。

Scenes
 

In
 

Build一栏是一个场景列表,默认是空的。如果在场景列表为空的时候发布,
则只会将当前正在编辑的场景发布出去并启动场景。这有利于我们快速做一些独立场景的

测试工作。正式发布的系统往往包含多个场景,有两种方式添加场景:
 

一是单击Add
 

Open
 

Scenes按钮,将打开正在编辑的场景加入栏目;
 

二是直接将保存的场景文件从Project窗口

拖动到发布窗口栏中。
拖动场景到列表中后,每个场景都被分配了一个数字,其中,0是漫游开始后第一个被

自动加载的场景。如果已经添加多个场景文件并且希望重新排列它们的顺序,只需要在列

表中选中并拖动以交换场景。选中一个场景并按Delete键就可以删除某个已经添加的

场景。
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图5.44 Build
 

Setting对话框

PC版本虚拟场景漫游系统在运行时,可以发布选择 Windows复选框,可以选择窗口运

行,可以设置窗口大小;
 

或者选择全屏运行。发布的可执行文件如图5.45所示。发布时建

议新建一个文件夹,单独存放发布出来的可执行文件及其配套文件,文件之间的相对路径保

持不变。

图5.45 可执行文件

小结

本章主要介绍了虚拟漫游的概念,了解虚拟漫游制作流程,并利用一个完整实例逐步讲

解了虚拟场景的创建和漫游实现,最后掌握虚拟场景跳转漫游与生成发布,发布出来的虚拟

漫游系统可独立运行。
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习题

一、
 

填空题

1.
 

虚拟场景漫游设计与实现方法可归纳为三种:
 

、 和 。

2.
 

虚拟场景漫游的制作技术主要包括 和 。

3.
 

虚拟场景漫游的制作过程通 常 分 为4个 步 骤:
 

、 、
和 。

4.
 

虚拟场景制作通常包括两种方法:
 

一种是 ;
 

另一种是 。

二、
 

简答题

1.
 

虚拟现实场景漫游方案具有哪些特色?

2.
 

请简述目前主流三维地形生成软件有哪些,各有什么特点。

3.
 

请简述虚拟漫游系统制作流程。


